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1: Introducing the USB modem 
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. Before you can begin using 

the USB modem 

. Package contents 

 

USB modem 
 

The USB modem is accessories for your PC that allow you to connect to the 

Internet, send and receive e-mail, connect to a corporate network/VPN, or view 

streaming video, without the need of a network cable or phone line. 

 

The USB modem fits into the standard USB port available on most notebook 

PCs. 

 

Supported operating systems 
The USB modem work in: 

 Notebook PCs running Windows 2000 and XP. 

 

HSDPA, UMTS, EDGE, and GPRS service support 
GPRS, EDGE, UMTS, and HSDPA are add-on data services to GSM mobile 

phone networks. The maximum data speeds when connected on these 

services are: 

 GPRS(General Packet Radio Service) – 56 kbps 

 EDGE(Enhanced Data GSM Environment) – 216 kbps 

 UMTS(Universal Mobile Telecommunications System) – 384 kbps 

 HSDPA(High Speed Download Packet Access) – up to 1.8 Mbps on 

the downlink (receive) with 500 to 800 kbps typical 

 

GPRS and EDGE are 2G(second generation) data services. 

UMTS and HSDPA are 3G(third generation) data services. 

 

When establishing a connection, your USB modem uses the fastest available 

service. If, for example, you are using an USB modem in an area that has 

GPRS and EDGE service but not UMTS or HSDPA service, the USB modem 

connects using EDGE service. 

 

These data connections are Internet connections. Once the connection is 

established, you can connect to any web site accessible through the Internet 



 3/28  

or use Internet services(such as e-mail). 

 

Frequency band support 
Every GSM network operates on one of these radio frequency bands, in 

providing 2G(GPRS or EDGE) service: 

 850 MHz band – (also called the cellular band) used by some North 

American service providers 

 900 MHz band – used by some European service providers 

 1800 MHz band – used by some European and Asian service 

providers 

 1900 MHz band – (also called the PCS band) used by many North 

American service providers 

 

Every network that offers 3G UMTS/HSDPA service does so on one of these 

bands: 

 WCDMA 2100 – used by European, Asian, and Australian service 

providers 

 

Your account and coverage area 
Companies that operate GSM networks and provide access to those networks 

are called service providers. You must have an account with a GSM service 

provider that offers HSDPA or UMTS service to use the USB modem’s 3G 

capability. (The USB modem is backward compatible to 2G service.) 

 

When you obtain your account, you are given a SIM card, also called a “smart 

card” or “smart chip”. (Depending on how you purchased your USB modem, 

you may already have an account, and your SIM card may have been included 

in your package.)  The SIM card contains account information and must be 

inserted in the USB modem anytime you use it. 

 

Before you can use the USB modem, you must install the USB modem 

software and ensure that your USB modem is configured to use your account. 

Instructions on completing these steps are provided in the chapters that follow.

 

Once installed and configured, you can connect to the Internet with the USB 

modem in any area in which you can obtain GPRS, EDGE, UMTS, or HSDPA 
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service. Your ability to obtain service depends on these factors: 

 Proximity to a GSM network – You must be within the coverage area 

of a GSM network in order to use the USB modem. 

 Service provider – If you are within the coverage area of a network 

that is not operated by your own service provider, you can only obtain 

service if there is a reaming agreement between your service provider 

and the network operator. 

 Account provisions – Your account may restrict your usage to certain 

networks of limit the amount of time you can use the network. 

 Frequency band – You cannot connect to networks operating in 

bands not supported by your USB modem, regardless of roaming 

agreements or account provisions. 

Most service providers have coverage maps on their web sites. 

 

USB modem software 
The USB modem comes with this software(made by Sierra Wireless): 

 The Watcher program that you use to manage the USB modem and 

monitor your connections.  

 The driver software that forms the interface between the USB modem 

and your Windows operating system. 

 The Network Adapter Manager software that allows you to switch 

between the USB modem and other network cards 

 

Before you can begin using the USB modem 
Before you can use the USB modem for the first time you must: 

1. Install the USB modem software : Watcher, the Network Adapter Manager, 

and the USB modem driver 

2. Insert the SIM into the USB modem and insert the USB modem into your 

USB port. (Do not insert the USB modem before installing the software.) 

3. Obtain a GSM account (if this wasn’t done when you purchased the USB 

modem). 

4. Configure the USB modem to use your account (unless it was pre-

configured.) 

5. If your Internet browser is configured to use a dial-up modem, you may need 

to set it to use a network card) 
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Package contents 
Your USB modem package contains the following: 

 USB modem 

 Installation CD containing the USB modem software and this 

installation guide 

 Quick start guide 

 Cradle 
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2: The SIM Card and Your Account 
. Inserting a SIM card into 

your USB modem 

. Removing a SIM card 

You require a GSM account and a SIM(Subscriber Identity Module)card to use 

the USB modem. The SIM card is a small chip(about the size of a postage 

stamp) that you insert into the USB modem. The SIM contains account 

information used by the network to validate your access. 

 

Depending on how you purchased your USB modem, you may already have 

an account. In this case, the SIM should be included in your package. 

Otherwise, your retailer should direct you to a local company that provides 

GSM service. 

 

To activate an account, the service provider needs from you: 

 Billing information (such as a credit card number) used to collect 

payment for your network usage 

 Possibly the IMEI(International Mobile Equipment Identity)- a number 

that identifies your device(USB model) on the GSM network.  

 

Your USB modem must be configured to use your account. If purchased from 

a service provider, your USB modem may have been pre-configured. 

Otherwise, you must set up a profile in Watcher.  

 

If you change GSM service providers(such as if you move to a new city), you 

will need a new SIM card from your new service provider. You will also need to 

set up a new profile. 

 

Inserting a SIM card into your USB modem 
To install your SIM card into the USB modem, follow these steps: 

1. Open SIM card door on the back of USB modem. 

2. Insert SIM card into SIM card slot 

3. Close SIM card door 



 7/28  

 

 

Removing a SIM card 
To remove your SIM card, follow these steps: 

1. Power off : If your PC is connected with USB modem, Select “Tool/Radio off” 

on Watcher. 

2. Remove USB modem from USB port of your PC. 

3. Open SIM card door on back of SIM card. 

4. Remove SIM card from SIM card slot, Close SIM card door. 
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3: Installing the 3G Watcher 
 1. Installation Wizard 

Double-click on the 3G_Watcher.msi icon and follow the Installation Wizard. 

Click on the Next button on the Wizard to move next step. 

 
 

2. Select the Region  
Select the region where the product has been purchased and click on the Next 

button to proceed further on. 
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3. License Agreement 
Read and Check the License Agreement. Select I accept the terms in the 

license agreement if you agree with the terms and click on the Next button to 

proceed further on.  
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4. Selecting destination folder for the installation 
To change the destination folder, click on the Change button and install or click 

on the Next button to install the program on the default folder 

 
 

5. Selecting a Modem 
Click on the Icon of Sierra Wireless HSDPA Embedded MiniCard to proceed 

further on 
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6. Setup Type  
Select Complete and click on the Next button to proceed further on. 

 
 

7. Ready to Install the Program 
Choose the Install button to install the program 

 
 

8. Installing Sierra Wireless 3G Watcher 
After the automatic installation, wait until the complete page is displayed. 
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9. Completing the installation  
Click on the Finish button to complete the installation.  

For more details about the use this program, refer to the help menu on the 

Watcher program 

 
 

10. Installing the USB Device  
For an Automatic installation, you have to connect the modem to an USB port of 
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your computer  

 
 

11. Installing the Serial Port  

 
 

12. Installing the Network Adapter  
After the automatic installation of the Network Adapter, double-click on the icon of 

the 3G Watcher on your desktop 
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4: Configuring Your Account 
. Setting up a profile 

 

Profiles contain account information used by the USB modem to establish 

connections. At least one profile must be set up on the USB modem before you 

can use it. The profiles(s) may have been stored on the USB modem before you 

purchased it. 

Otherwise, your service provider should give you all the information you need to 

set up the profile(s) you require. 

 

Depending on your service provider, some or all of this information must be 

entered into your profile: 

 User Name 

 Password 

 APN(Access Point Name) 

 IP(Internet Protocol) Address (if the address is not automatically 

assigned by the network) 

 Use of IP header compression 

 DNS(Domain Name Server) address or addresses 

 

Your service provider may give you only one APN in which case you require only 

one profile. Some service providers assign separate APNs for separate 

purposes. For example, some service providers supply one APN to use for 

Internet browsing and a different APN to use with a VPN. In this case you must 

set up multiple profiles. The USB modem allows for up to sixteen profiles. 

 

Most service providers have one or two standard profiles that all or most of their 

subscribers are expected to use. Most of these standard profiles have been pre-

defined in Watcher, allowing you to select a standard profiles, rather than 

creating it manually. 

 

One of your profiles must be set as the “default” profile. This is the one that is 

used if you select the Connect button without selecting a profile. The default 

profile is also used if you set the USB modem to autoconnect. If you are using 

the USB modem to access a network that requires you to provide a password 

each time you connect, you must set the connection mode for your profile to 
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prompt for password(in which case you must connect manually). 

 

Setting up a profile 
 

To determine whether you have a profile: 

1. Insert the SIM into the USB modem if it is not already inserted. 

2. Insert the USB modem into the USB port if it is not already inserted. 

3. If Watcher is not running, start Watcher, by selecting Start > Programs > Sierra 

Wireless > 3G Watcher > 3G Watcher 

 or double-click the desktop shortcut. 

If Watcher detects that no profile has been set up, you are prompted, “Would 

you like to configure a profile now?” Select Yes. 

If this prompt does not appear, your USB modem may have been 

preconfigured. You can verify that you have a profile by selecting Tools > 

Connections to access the USB modem tab of the Connections window which 

lists all profiles. 

 

To create a profile: 

1. On the Connections window, select the Add button. 

2. If you want to use a pre-defined profile, in the Profile Name field, select the 

profile from the drop-down list. Then skip to Step 5. 

3. Complete the fields in the USB modem Profile window by entering a Profile 

Name(any meaningful description of the profile, such as the name of your 

service provider) and User Name, Password, and/or APN, if applicable. 

4. Select whether you want to make connections automatically or manually, or 

whether you are required to provide a password each time you make a 

connection :  

 If you select Autoconnect, a connection is established automatically 

whenever you insert the USB modem.  

 If you select Manual, you must select the Connect button on the main 

Watcher window to make a connection. 

 If you select Prompt for Password, you must select Connect and enter a 

password to make a connection. Use this option if you have an external 

device that provides a time-scheduled secure password for your 
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corporate network. 

5. If you want to set Watcher to launch your Internet browser, VPN, or any other 

program automatically, or if your service provide specified an IP address, DNS 

address(es), or Quality of Service (QoS) parameters, select the Advanced 

button to open the Advanced Profile window. Otherwise, click OK and skip to 

Step 12. 

6. On the Autolaunch tab, select which application, if any, you want Watcher to 

automatically launch when a connection is established with this profile: 

 None – Select this if you do not want any application to be 

autolaunched. 

 Browser – Select this if you want Watcher to autolaunch your Internet 

browser ( such as Internet Explorer or Netscape Communicator) when 

a connection is established with this profile. In the URL field, specify the 

web site (such as http://www.sierrawireless.com) you want to view on 

connection. 

 Microsoft VPN (PPTP) Connection – Select this if you want Watcher 

to autolaunch a VPN connection that you have set up in Windows when 

a GPRS, EDGE, or UMTS connection is established with this profile. 

From the drop-down list, select the VPN connection. 

 Application (VPN Client, etc…) – Select this if you want Watcher to 

autolaunch an installed VPN program, or any other program, when a 

GPRS, EDGE, or UMTS connection is established with this profile, In 

the field below, enter the path to the program, or use the Browse button 

to locate the program. 

7. If your service provider has given you an IP address, on the TCP/IP tab, select 

Use static IP address and enter the address in the field below. Otherwise 

select Use dynamic IP address. (This is the default because most networks 

use dynamic IP addressing.) Use the check boxes to enable data compression 

of IP header compression if supported by your service provider. 

 

Note: The Use IP header compression field should NOT be checked unless 

your service provider is using this compression. The USB modem cannot 

maintain a connection if this is enabled but not supported on the network. 

 

8. If you have a DNS address or addresses, select the DNS tab and enter the 

address(es). (In most cases, it is not necessary to enter a DNS address.) 
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9. If your service provider specifies values for Quality of Service (QoS) 

parameters, enter those settings on the appropriate tabs (Minimum QoS and 

Requested QoS). (In most cases it is not necessary to adjust Quality of 

Service parameters and the tabs do not appear.) Do NOT change any Quality 

of Service parameters unless advised to do so by your service provider. 

10. Select OK to close the Advanced Profile window. 

11. Select OK to close the GPRS Profile window. 

12. If you have more than one profile, use the Default Profile radio button to 

select which is the default.(The “default” profile is the one used by the 

autoconnect feature and is used if you select Connect without selecting a 

profile.) 
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5: Watcher™ Basics 
. Launching Watcher 

. The Watcher window 

. Icons and indicators on 

the main Watcher window 

. View options 

. Status icons 

. Frequency band and 

network selection 

. Frequency band selection 

. Network selection 

Watcher is the program you use to manage and monitor your USB modem 

connections. Watcher allows you to: 

 Create an account profile. (This is explained under ”The SIM Card and 

Your Account”.) 

 Determine signal strength, roaming status, GPRS/EDGE/UMTS/HSDPA 

availability, and other network connection parameters 

 Monitor the status of the USB modem and GSM service 

 Initiate data connections 

 Enable or disable SIM security that prevents others from using your 

SIM card if it is lost or stolen 

 Set options related to notifications and the Watcher window 

 

If you set your account profile to autoconnect, you do not need to run Watcher 

when you user the USB modem, but Watcher does provide useful status 

information. 

 

Launching Watcher 
On notebook PCs, unless the feature has been disabled, Watcher launches 

automatically anytime you insert the USB modem. You can also launch Watcher 

by: 

 Double clicking the desktop shortcut,  or  

 Selecting Start > Programs > Sierra Wireless > 3G Watcher > 3G 

Watcher 

 

Depending on how your profile is configured, your browser, VPN, or other 

program may launch automatically anytime you launch Watcher 
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The Watcher window 

 
Icons and indicators on the main Watcher window 
These icons are used on the main Watcher window: 

Icon Meaning 

 

Device status. If an USB modem icon with an “X” 

is displayed, Watcher is unable to detect the USB 

modem. The ToolTip that displays when you 

position the mouse pointer over this indicator 

says, “Device not available”. This usually indicates 

that the USB modem is not fully inserted into the 

USB port. 

 

If an USB modem icon with a “?” is displayed, 

Watcher has detected the USB modem but is 

unable to communicate with it. The ToolTip that 

displays when you position the mouse pointer 

over this indicator says, “Device not responding “. 

You may be able to resolve this problem by 

restarting Watcher, by stopping, ejecting, and 

reinserting the USB modem, or by restarting your 

PC. 
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Signal strength and service status. The number of 

bars beside the antenna increases as signal 

strength increases, to a maximum of five bars. 

The ToolTip that displays when you position the 

mouse pointer over this indicator, shows the 

numeric value of the RSSI(Received Signal 

Strength Indication in dBm). 

 

Blank bars in the signal strength indicator mean 

that you are outside of the coverage area or have 

insufficient signal strength to maintain a GSM data 

connection. 

 

A red thermometer icon indicates overheating. In 

the unlikely event that this occurs, the USB 

modem suspends data transmission until the 

temperature drops, then normal operation is 

resumed. (This usually takes no more than 10 

seconds.) 

 

A red flashing antenna icon indicates an antenna 

problem. If this occurs, try reorienting the antenna 

and ensure that there is nothing on or near the 

antenna that could be blocking the signal. 

 
Coverage. The icon shows the best service 

available where the: 

 

gprs icon – indicates that GPRS is the fastest 

service available 

edge icon – indicates that EDGE is the fastest 

service available 

3G -  indicates that UMTS is the fastest service 

available 

HS – indicates that HSDPA is the fastest service 

available. 

 

When only the letters are displayed, you are 

within coverage but have not yet acquired the 

service. 

 

When the indicator has an outline, you have 
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acquired service and are able to establish a 

connection. 

 

When the indicator is filled, you have a connection 

on the service. 

 

Roaming. When displayed, you are connected to 

a network other than your local service provider’s. 

There may be a surcharge for roaming service. 

 

New SMS message. Select the icon to open the 

SMS Express window and read your messages. 

When your SIM becomes full, this icon flashes 

and turns red. 

 

Data transmission. When this indicator is on and 

neither circle is shaded, you have a connection 

but no data transmission is occurring. 

 

A shaded top circle indicates that data is being 

sent and a shaded bottom circle that data is being 

received. 

 

Theses statistics are displayed during  

GPRS/EDGE/UMTS/HSDPA connections only; no 

statistics are displayed for dial-up connections. 

 

View options 
 

On notebook PCs, you have these options concerning the Watcher window: 

You can enable/disable always on top from the View menu. When enabled, the 

Watcher window always appears in front of other application windows. 

You can switch between the full Watcher window and the compact window from 

the View menu or by using the Compact View button: 

 
You can use the Minimize button to close the Watcher window but leave the 

program running. 
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Status icons 
 

These icons appear in the system tray (usually in the lower right corner of your 

screen). 

Icon Meaning 

 

You have a GPRS, EDGE, UMTS, or HSDPA 

connection. 

 

You do not have a GPRS, EDGE, UMTS, or 

HSDPA connection. 

 

You have one or more unread SMS messages. 

 

Power Down and Up 
 
The power down/power up option allows you to conserve your battery by 

powering the USB modem down when you are not using it. 

To power down the USB modem: 

1. Select Tools > Turn Radio off 

When powered down, the menu options switches to Turn Radio on and the 

message, “Radio is Off” is displayed on the Watcher window. 

You cannot maintain a connection when the USB modem is powered down. 

 

Frequency band and network selection 
 

Watcher has two options that affect your ability to obtain GPRS, EDGE, UMTS, 

or HSDPA service in any given area. You can select: 

 The frequency band you want to use 

 The network you want to use, if you are within the coverage area of 

more than one network 

 

Frequency band selection 
Every GSM network operates on one set of frequency bands. The USB modem 

is designed to change frequency bands automatically as required to obtain 

network service. You can also change frequency bands manually from the 
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Network tab of the Options window (Tools > Options > Network). 

 

Note: Unless your service provider specifies otherwise, it is recommended 

that you use the Auto setting. 

 

Network selection 
Depending on your location, you may be within the coverage area of several 

networks. Your ability to obtain service on each network is dependent on your 

account. 

 

Your options for network selection are: 

 Automatic – The USB modem automatically selects a network based 

on your account and network availability. 

 Manual – The USB modem scans the area and displays a list of 

detected GSM networks. You can then choose from a list of available 

networks. 

 

If you select a network on which you cannot obtain service, the message, “Failed 

to register with network” appears. You should then choose a different network. 

 

This option is set on the Network tab of the Options window (Tools > Options > 

Network). 
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6: Technical Specifications 
 This chapter describes the operation of the LED and provides technical data for 

USB modem. 

 

LED state How to interpret 

Off Not Powered 

On Powered, associated, and authenticated and 

s/w upgrade but not transmitting or receiving

Slow Blink Powered but not associated or 

authenticated; Searching 

Green 

Intermittent 

Blink 

Activity proportional to transmitting/receiving 

speed 

Off Not Powered 
Red 

On Powered 

 

Radio frequency and electrical specifications 

Compliance GSM Release 99 

 

Multi-slot class Class 10 

Transmit PCS:  

1850 to 1910 MHz 

DCS1800: 

1710 to 1785 MHz 

EGSM900: 

880 to 915 MHz 

GSM 850: 

824 to 849 MHz 

WCDMA2100 

1920 to 1980 MHz 

Receive PCS: 

1930 to 1990 MHz 

DCS1800: 

1805 to 1880 MHz 
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EGSM 900: 

925 to 960 MHz 

GSM850: 

869 to 894 MHz 

WCDMA2100: 

2110 to 2170 MHz 

Channel spacing 200 kHz(GSM) 

5 MHz(WCDMA) 

Channel raster 200 kHz 

Frequency stability 0.1 ppm 

 

Environmental specifications 

Operating temperature -20 to +60°C 

Storage temperature -30 to +75°C 

Humidity 95%, non-condensing 

Vibration 15 g peak 10 to 2000 Hz(non-operating) 
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7: Regulatory and Safety Information 
. Important notice 

. Safety and hazards 

 

Important notice 
 

Because of the nature of wireless communications, transmission and reception 

of data can never be guaranteed. Data may be delayed, corrupted (i.e.,have 

errors) or be totally lost. Although significant delays or losses of data are rare 

when wireless devices such as the Sierra Wireless network card are used in a 

normal manner with a well-constructed network, the Sierra Wireless network 

card should not be used in situations where failure to transmit or receive data 

could result in damage of any kind to the user or any other party, including but 

not limited to personal injury, death, or loss of property. Sierra Wireless and its 

affiliates accept no responsibility for damages of any kind resulting from delays 

or errors in data transmitted or received using the Sierra Wireless network 

card, or for failure of the Sierra Wireless network card to transmit or receive 

such data. 

 

Safety and hazards 
Do not operate your USB modem : 

 In areas where blasting is in progress 

 Where explosive atmospheres may be present including refueling 

points, fuel depots, and chemical plants 

 Near medical equipment 

 Near life support equipment, or any equipment which may be 

susceptible to any form of radio interference. In such areas, the USB 

modem MUST BE POWERED OFF. Otherwise, the USB modem can 

transmit signals that could interfere with this equipment. 

 

In an aircraft, the USB modem MUST BE POWERED OFF. 

Otherwise, the USB modem can transmit signals that could interfere with 

various onboard systems and may be dangerous to the operation of the 

aircraft or disrupt the cellular network. Use of a cellular phone in an aircraft is 

illegal in some jurisdictions. Failure to observe this instruction may lead to 

suspension or denial of cellular telephone services to the offender, or legal 

action or both. 



 28/28  

 

Some airlines may permit the use of cellular phones while the aircraft is on the 

ground and the door is open. The USB modem may be used normally at this 

time. 

 


